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Upcoming QuickPix – There are a few opportunities in April and May to share your images 
with the rest of the club before our regular meetings.   
 Eastern Sierra – submit images between March 28th and April 4th 
 Abstracts and Patterns – submit images between April 11th - 18th  
 Travel Photos – submit images between April 25th and May 2nd 

 
Field Photographic Techniques – Begins on April 19th.  Don’t miss the opportunity to work 
one-on-one with instructors in some of the best photographic locations around town.  
Enrollment is strictly limited to 15 students.  Information on enrolling is on Page 7. 
 
ColorMunki – Have your photos submitted for QuickPix, Members’ Night, or competitions not 
looked the way you expected?  The problem is probably a difference in how your computer 
and the club projector display colors and brightness.  You can fix this by calibrating your 
computer the same way our club calibrates our projector – with the ColorMunki.  Set up is 
simple and the calibration process only takes a few minutes.  Contact Lois Ritchie-Ritter at 
loisritchie@yahoo.com to reserve the ColorMunki. 
 
Photogram – If you have photo equipment that you are looking to sell, why not let club 
members know.  Send your submissions to carl.oday.rcc@gmail.com by the third Thursday of 
the month to be included in the following Photogram. 

Programs for April & May 2016 

 

Details for the current month’s programs may be found in the Programs article, starting page 3.

  

April 4th April 18th May 2nd May 16th 

Shooting the 
Eastern Sierra 

 
With Bob Fletcher 

 and Friends  

Discovering 
Abstracts and 

Patterns 
 

With Jerry Reece 

 Shooting Cuba  
 

Rick Strobaugh 
Caroline McAllister 

Penny Schwartz 

Members’ Night 
 

With Live Edits 

PHOTOGRAM 
Monthly Newsletter of the Redlands Camera Club 

April 2016 

Redlands Camera Club meets:  1st & 3rd Mondays, 7:00 pm 
First Presbyterian Church - 100 Cajon St - Redlands, CA 

Guests are always welcome 
 

© Redlands Camera Club & Contributors  The contents of the Photogram are copyrighted.  No material herein may be reproduced in any 
Manner without the written permission of either the Editor or the material’s specific contributor. 
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Carl Detrow 
 
      

Oops! There’s a word we’ve all used in circumstances ranging from humorous to dire. I 
remember years ago having purchased a point-and-shoot camera that talked to me, 
and I hoped it would prevent the dreaded “oops.” The Canon Talker would, in a polite 

female voice with a slight Japanese accent, advise me to use flash or even to load film when 
necessary. There were a few other things it said, but none critical, so I quickly learned to ignore them. 
One day, however, I took several pictures while ignoring the “load film” that chirped out on every 
exposure. I finally realized my error, but only after missing several good shots. At least I didn’t waste 
any film. 

For many years I lived in a military world. The military is forced to relegate many complex and often 
dangerous tasks to the young and inexperienced. They respond with plenty of good training and a ton 
of standardization. That means everybody does the same job the same way, and to make sure, the 
brass provided us with checklists. As my memory continues to go south these days, I find checklists 
to be more and more useful in preventing “oops” moments. 

Acronyms were a good way to remember checklists when they weren’t written down and being 
recited by the co-pilot. Ask any pilot from the old days what GUMP (as in Andy of the comics, not 
Forest) means and you’ll see a flicker or recognition, a wry smile, and may even get a war story. As a 
photographer, I’ve come up with a little acronym myself to avoid the dreaded oops – FOCUS. The 
word here has more to do with preparing for a shot than what my wife used to yell at her father during 
his slide shows. 

F – is for “field of view.” When you look through the viewfinder, think about what you are seeing. Do 
you see a huge historic building with a tiny person in front of it? How much of what fills the frame 
really needs to be there? But don’t restrict it too much. One photographer in our club advises to 
always leave room to crop, to accommodate a particular framing need later. 

O – is for “object.” One of the chief criticisms I hear from judges and reviewers is that he or she can’t 
figure out what the picture is supposed to be about. So think about your subject. If you don’t know 
what you are trying to say, your viewer will probably not be able to figure it out either. 

C – is for “composition.” We’ve had several excellent presentations on composition at the club, and 
they have easily been what have made me a much better photographer than I was when I joined. As 
you look at your planned image think about the “rule” of thirds, leading lines, s-curves, and odd-
numbered groups. Watch out for those glaring background areas and save yourself some Photoshop 
time later. Use your understanding  of depth-of-field to your advantage.  

U – is for “up.” I’ve noticed when I crop that, like a good barber, I often have to take some off the top. I 
get so focused on my subject that I forget what’s behind or above him. I remember a really good 
picture of a couple at church that was ruined by the cross on the steeple growing straight out of his 
head. If I had only looked up, I could have avoided the “oops.” (I’ve got to remember to give that one 
to the pastor as a sermon topic.) 

S – is for “shoot.” It took us a while to get here, but a good review of the FOCUS checklist should help 
to avoid the dreaded “oops.” Shoot the good shot instead of shouting, “Oh, shoot.” Shoot a couple 
more with minor adjustments just to be sure. Don’t worry about wasting film. As Frank says, “Memory 
is cheap.” 

 

Happy shooting! 
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Jim Hendon 

 

 

 

April 4
th

 – Shooting the Eastern Sierra 
With Bob Fletcher and Friends 

 

The Eastern Sierra Nevada -- it’s “our Yosemite,” offering easy photo 
access to Mt. Whitney, the Alabama Hills, the Owens Valley, soaring 
peaks and jagged canyons. And don’t forget Bodie, the ancient 
Bristlecone pines, Mono Lake and blazing autumn colors. We can 
never exhaust this photographer’s paradise. But with inspiration, we 
can try! First, we’ll enjoy Eastern Sierra Quickpix from RCC members 
(submit to RCC web site March 28 to April 4). Then, three 
handpicked panelists will share stories, secret spots and best times 
to shoot. To top off the program, we’ll hear from pro Canon shooter 
Bob Fletcher, the intrepid Eastern Sierra explorer and photo 

workshop leader. Stick around for a lively Q&A and take home some tips for your next Eastern Sierra 
adventure! 

April 18
th

 – Discovering Abstracts and Patterns 
With Jerry Reece 

Photography offers us limitless artistic possibilities, and nothing sets 
the shooter free like abstract subjects and compositions – light, color, 
shadow, patterns. Come explore this topic with RCC past president 
Jerry Reece, who recently began focusing on abstracts after finding 
patterns in both wild and urban settings. What’s an “abstract” image? 
Perhaps it’s when a composition itself becomes more visually 
powerful than its literal subject. With words and pictures, Jerry will 
share how to “see” abstracts and where to find them in nature, 
around town and even around the house. He’ll also talk about his 

recent foray into camera-in-motion abstracts. Beyond image capture, Jerry will discuss using 
Photoshop filters and plug-ins to create a variety of abstracts. Jerry last challenged us in 2105 with 
his presentation on fisheye photography. Join us April 18 for some fresh creative inspiration from this 
veteran photographer. For fun before the program, we’ll also share Quickpix of abstracts and patterns 
(submit to RCC web site April 11-18). 
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May 2
nd

 – Shooting Cuba 
Rambling Redlanders Talk Travel Photography 

Travel photos. We all shoot them, but how do we capture images as 

vivid as our best memories? Join us May 2 to hear from three well-

traveled Redlands shooters – Rick Strobaugh, Caroline McAllister 

and Penny Schwartz. Strobaugh, RCC’s chief mentor and a frequent 

winner of our competitions, will focus on the value of researching key 

locations and photo opportunities ahead of a trip. McAllister, a former 

high school photography teacher, and Schwartz, a journalist and 

photographer, will share lessons from shooting in Cuba, one of today’s hottest photo destinations. 

Last year, they shared 70 of their best Cuba images in an exhibit at San Bernardino Valley College. 

VP Jim Hendon will share tips on shooting in Europe – and we’re hoping other RCC shutterbugs will 

jump in with lessons of their own. Be sure to submit your travel Quickpix to help us get a good 

discussion going (from noon, April 25 to noon, May 2). 

May 16
th

 – Members Night with Live Edit 
 

We plan to again give our photo reviewers early access to our 

images, plus our handpicked Live Editors will also see the photos 

before the program. The result should be more comprehensive and 

valuable feedback -- and better suggestions for improvement -- than 

ever before. More information to come. 

 

  
Rick Strobaugh

 

 

Pre Meeting Mentoring – April 18
th

 

Rick Strobaugh will be holding another pre-meeting discussion group on April 18. These are for any 
members who want to discuss ways to improve their photographic skills or gain more understanding 
of techniques. We meet at 5:30 at our normal meeting location. Anyone who is interested, contact me 
at rpdrunner@msn.com with a list of any subjects you would like to discuss. 
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John Williams

 

 

Now is the time to renew your Membership for FY 2016-2017! 
 

Please note if you haven't already paid your club dues, your Membership is now pass due.  Our 
membership year runs from April 1, 2016 to March 31, 2017.  So, please bring your check (or cash) to 
the next meeting.  Renewal applications forms will be available at our regular club meetings.  It's easy 
for you to renew.  The only thing you need to do is to check the information, note any changes, let us 
know if you want to be included in the Club Roster and turn in your dues.  Membership is $25.00 for 
an individual or $45 for two memberships if the second person is in the immediate household.  Please 
make checks payable to Redlands Camera Club.  Note if you are a new member and joined between 
Jan 1 to March 31, 2016, you are considered to be a member in good standing until March 31, 2017. 

This year, we are printing a Club Roster for distribution to our membership.  Please indicate on the 
renewal form if you want to release your personal information (name, phone number and email 
address). 

We have a total of 161 members in good standing.  Please help welcome our new members and 
direct them to members who can help them become a better photographer.  We try to get a brief Bio 
from each of our new members.  Contact me by email (jhwr@earthlink.net) if your Bio has not 
appeared and you wish to have it included in the Photogram. 

Prospective new members please note:  At Redlands Camera Club you’ll find a group of photo-
enthusiasts with a wide range of interests, a ton of experience and a willingness to share.  Our 
regular club meetings offer stimulating programs, members’ nights and competitions; in addition, we 
offer field trips, workshops, classes and opportunities for mentoring.  You can obtain an application 
form at one of our regular meetings or from our website by going to the club web site 
(www.redlandscameraclub.com), clicking on the “Downloads” tab and then clicking on “Membership 
Application” tab.  Follow the instructions on the form and your all set!  Dues are the primary sources 
of club revenue allowing us to provide you with quality programs and training.  Only currently paid 
members can take part in RCC classes, events, free workshops, field trips and competitions. 

Please welcome our newest members who joined in the month of March: 

Charles (Greg) Johnson 

Mark Messersmith 

Monica Mikhail (free membership for her excellent entry in the Redlands Council of PTAs' 
photography competition) 

Karen Romero 

mailto:jhwr@earthlink.net
http://www.redlandscameraclub.com/
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Russ Trozera 
 

 

2016 Spring Competition 

The Redlands Camera Club  would like to congratulate   Rick Strobaugh  for Best of Show in our 
2015 Winter Competition.  Rick’s image Full Moon at Death Valley scored 90.20. We would also like 
to congratulate all those that participated and also won ribbons. It was a very good competition. Our 
next competition is in June 2016. Where you can enter  up to 3 images. Just a plug for Rick, Rick 
Strobaugh will be holding another pre-meeting discussion group on April 18. These are for any 
members who want to discuss ways to improve their photographic skills or gain more understanding 
of techniques. We meet at 5:30 at our normal meeting location. 
 

Debra Dorothy  

             
 

Huntington Library and Botanical Gardens 

 

Date: April 21st 

Location:   

   The Huntington Library and Botanical Garden 

   1151 Oxford Rd. 

   San Marino, CA 91108 

Ticket Price: $23.00 

 

We will leave the Coco's Bakery Restaurant 1140 W Colton Ave, Redlands, CA 92374 at 10:30 to 
carpool to event. Please email me ahead of time to let me know if you are attending and also if you 
want to carpool.  Debbiedsd.dorothy@gmail.com 

If you have any questions you can call me at 909 633-2913 or email me at 
Debbiedsd.dorothy@gmail.com 

Hope you all can make it! 
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Frank Peele  
 

RCC School of Photography Courses and Workshops 

 

Redlands Camera Club School of Photography’s next course, Field Photographic Techniques, will 
begin on April 19. This is the most sought-after course we offer, because it presents unmatched 
opportunities to shoot in some of the area’s most iconic locations at interesting times of light. Since 
some of these locations are not normally open to the public when the light is at its best, this class is 
the best chance you’ll have to capture some very special images. Enrollment is strictly limited to 15 
students. For more information and to register, click here. 

 

 
 
Our next workshop will be combined with a field trip, and it’s a big one! The California State 

Railroad Museum in Sacramento houses a treasure-trove of historical railroad exhibits, including 
beautifully maintained locomotives and rolling stock. Photographing the exhibits is normally difficult, 
because interior light levels are low and tripods are not allowed. But twice a year, they open up to 50 
photographers and their tripods during two special events called “Trains & Tripods”. On Friday, May 
6, an evening educational session will prepare the group for shooting the exhibits. Then on Saturday 
morning, May 7, the museum will open early (and only to the 50 ticket-holders and their equipment) 
for a nearly-unlimited-access session with the exhibits, both inside and outside. 
 
  

http://www.redlandscameraclub.org/education%20workshops.htm
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 The club has reserved 12 tickets for this special event, and 2 are now available to the first 
responders. The price is $60 for both Friday and Saturday events. We plan to carpool leaving Friday 
morning, May 6, and returning on Sunday, May 8. For more about the museum and this special 
event, click here. To claim your spot in the group, send an email to Frank Peele here. 
 

 
The following month will see us engaged in another workshop/field trip combo: photographing the 
night sky and a trip to Borrego Springs! We last did this excursion in August of 2015; this year we 
want to beat the harsh summer temps and still enjoy the wonder of the night sky in a special place, 
made all the more picturesque by some 130 large metal sculptures. The date for the workshop, which 
will precede the field trip, will be scheduled for late May. The date of the field trip will be Sunday, June 
5. Stay tuned for more details to come!  

If you have any questions, please email:  educationworkshopsrcc@gmail.com. 

 
Judith Sparhawk 
Redlands Art Association Photography Show  

RCC has again been invited to show our flower or garden photography in conjunction with Redlands 
Horticultural Society’s annual Garden Tour.  For the last two years we have had display space in the 
beautiful Cutler Building, and we will again have this attractive site. 

The Garden Tour will be held on Saturday and Sunday, April 16 & 17th, and the framed prints will be 
brought in on that Saturday morning for hanging, with pick-up on Sunday.  The exact times will be 
announced closer to the event. 

Tickets to the Garden Tour are $15.00 and kids under 13 are free (with adult).  More details can be 
found at http://redlandsgardenclub.com/garden-tour.html.  

http://www.csrmf.org/component/content/article/73-whats-new/300-lights-camera-action-special-trains-a-tripods-photo-opportunity-a-lighting-seminar
mailto:educationworkshopsrcc@gmail.com
mailto:educationworkshopsrcc@gmail.com
http://redlandsgardenclub.com/garden-tour.html
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Wayne (Woody) Wood 

 
 

Drew Morgan 

 

I fell in love with photography about 20 years ago while on vacation in 
Southern Germany. I was given a Minolta Freedom II camera to take with 
me so I could take snap shots of my vacation. But after having seen the 
quality of the pictures as well as having those special memories of my trip, 
my love and passion for the camera started. 

After using my Minolta for several years, and having to develop a couple 
hundred rolls of film, I decided to upgrade to a Sony Cyber-Shot camera to 
get into the digital era. With my new digital camera, my passion only grew 
more and more for taking pictures. I wanted to get out more frequently and 
photograph. I have some great memories traveling up throughout the East 
Coast where I grew up, taking pictures in upstate New York and Vermont 
during fall foliage season. And now living in Southern California for the 
past six years, there are some many places to visit and photograph, I will 
never get bored or have lack of subjects to shot. 

I predominantly photograph landscapes, flowers and anything to do with nature. I love being outdoors 
and hiking, and I always bring my camera along for the ride so I don't miss that magical shot. And 
now that I also have a GoPro, I take it along as well for some fun videos for my hikes and capturing 
the kids. 
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2016 Spring Competition – Best of Show 

 
Full Moon at Death Valley 

Rick Strobaugh 
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2016 Spring Competition – First Place 
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Club Calendar   

             Information that was available to the editor at the time of publication.  
 

April 4 Shooting the Eastern Sierra with Bob Fletcher and Friends 

April 16 & 17 Redlands Garden Tour 
RCC images displayed in the Cutler Building 

April 18 Discovering Abstracts and Patterns with Jerry Reece 

April 19 Field Photographic Techniques course begins 

April 21 Field Trip: Huntington Library and Botanical Gardens 

May 2 Shooting Cuba with  
      Rick Strobaugh, Caroline McAllister, and Penny Schwartz 

May 6-8 Field Trip: California State Railroad Museum 

May 16 Members’ Night 

June 5 Field Trip: Borrego Springs 
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(Note:  The views expressed in this article are those of the author and do not  

necessarily reflect the views of the Photogram or of Redlands Camera Club.) 

 
Add Rays of Sunlight 

By John Williams 
 

This techniques uses a scattered brush to create light beams. 

 Add a new transparent layer (depress the Create new layer icon or Shift+Ctrl+N). 

 Select the Brush tool (B) with an Opacity of 100%, Hardness of 50% and Flow of 50% (increase 
Flow for more pronounced rays).  Sample a color 
near the light sources that is not pure white.  A 
white-yellowish color sometimes works best.  
Depress the Alt key and with the eyedropper tool 
select the color.  The Foreground color swatch will 
reflect your color selection. 

 Create individual spots of light using the 
Brush tool:  Choose Window>Brush to bring up 
the Brush options. 

 Shape Dynamics:  Click on the word Shape 
Dynamics (left column) and move the Size 
Jitter slider to 100%.  Next move the 
Minimum Diameter slider to 0%. 

 Scattering:  This will change the brush into a 
scattering of dots.  Check the Both Axes box 
and move the Scatter slider to the maximum value (1000%). 

 Brush Tip Shape:  Click on the Brush Tip Shape button and at the bottom of the Brush Tip 
Shape section, change Spacing to about 90%.  Refer to the Preview section at the bottom of 
the dialog box and slide the Spacing slider.   

 With the New layer highlighted, paint on your image.  You will notice a cluster of different size 
dots are randomly placed as you paint.  Be sure to paint a cluster of dots around your light 
source (Sun).  The size of the brush is important to get the proper affect.  If your dots are too 
large, then decrease the brush size (depress and hold the Ctrl+Alt keys, right-click on the 
image, and move the mouse to the left).  The smaller the dots, the narrower the light beams. 

 Light Rays:  Choose Filter>Blur>Radial Blur.  The amount should be set to max (100) and the 
Blur Method should be set to Zoom.  Move the blur center 
point over the approximate light source point.  Note the 
document window will not display a preview.  Therefore, you 
will need to guess where to place the source point.  Depress 
the OK button.  

 Create a Light Ray variation from the first one:  Create a 
new layer and with a different size brush, paint over the 
image.  Try a smaller size brush which will give you narrower 
light beams.  To quickly apply the radial blur affect, depress 
Ctrl+F (shortcut for applying the last Filter). 
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 Center the light rays originating point over the light source.  Select the Move tool (V) and select 
both Radial Blur layers (click on one layer and hold down the Shift while clicking on the other 
layer).  Depress the Ctrl+T keys to transform and move the light rays. 

 Merge Radial Blur Layers:  Individually view each blurred layer and reduce the layer Opacity to 
taste.  Determine which blurred layer gives you the best result and discard the other blurred 
layer.  However, If the combination of both layers give you the best result, then merge the two 
Radial Blur layers (Ctrl+E). 

 Change the Blending mode:  Generally Screen or Color Dodge work best; however, check all 
the other blending modes.  To quickly scroll through the different blend modes, make sure the 
active tool you have selected doesn’t have a Blend Mode selection (found in Options bar) such 
as the Move Tool.  Click on the document photo and then depress the Shift key.  Then depress 
the +/– keys to scroll through all the blend modes.  Then change the layer Opacity to taste, if 
necessary. 

 Apply a Hue/Saturation adjustment:  Make sure you are on the merged layer and depress 
Ctrl+U (Image>Adjustments>Hue/Saturation).  Adjust all three sliders to your liking.  Most 
likely you will only need to adjust the Lightness slider. 

 Add a Mask to the merged layer and paint out sunbeams you do not want. 

 

 
 
 
 
 

Redlands Camera Club    P.O. Box 7261 Redlands, CA 92375 

www.RedlandsCameraClub.com 

Officers (2015-2016) 

President:  Carl Detrow     Vice President/Programs:  Jim Hendon     Secretary:  Judith Sparhawk    

Treasurer:  Joe Ligori      Past President:  Steve Oberholtzer      Member-at-Large: Jerry Reece 

Chairs (2015-2016) 

Color Munki:  Lois Ritchie-Ritter      Competition:  Russ Trozera     Education/Workshops:  Frank Peele    

Facebook/Event Photographer:  Bruce Woodcock        Field Trips:  Debra Dorothy      

Historian:  Bruce Bonnett       Hospitality/Events:  Lucy McGee      Librarian:  Mary Ann Ponder      

Membership:  John Williams       Mentor:  Rick Strobaugh     Photogram: Carl O’Day       

Publicity: Alex Woodcock         S4C:  Deborah Seibly      

Webmaster: Wayne (Woody) Wood       Welcome:  Stephanie Billings 

 

http://www.redlandscameraclub.com/

